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CHAPTER 

1 

1 Introducing Cantabile 
Welcome to Cantabile! 

Cantabile is a simple to use host for virtual music instruments and audio effects with an 

emphasis on real-time performance and use in live performance situations. 

Editions 

Cantabile comes in three editions: 

Cantabile Lite  A free, simple to use, yet high performance host designed for use as a 
quick VST scratch pad, or for users just getting started. 

Cantabile Solo Intended for home hobbyists and casual users who need a more 
flexibility, including unlimited plugins and racks, preset morph and 
randomize tools, MIDI filters, MIDI controller assignments and session 
lists. 

Cantabile 
Performer  

Designed specifically with live performance in mind, Performer adds 
features like sub-sessions, MIDI Clock, MIDI routing tables and triggers. 

This manual covers all three editions.  Features not applicable to particular editions are 

appropriately marked. 

x64 Editions 

All three editions of Cantabile are available in x86 and x64 versions.   

x86 This is the standard 32-bit version of Cantabile 

x64 The 64-bit version requires a 64-bit operating system (eg: Vista x64) and 
compatible x64 plugins.  

Cantabile x64 will not load standard x86 (32-bit) plugins. 

The term x64 should not be confused with 64-bit audio which is a different sound format and 

supported by both x86 and x64 versions of Cantabile. 

)Æ ÙÏÕȭÒÅ ÎÏÔ ÓÕÒÅ ÁÂÏÕÔ ÁÎÙ ÏÆ ÔÈÅ ÁÂÏÖÅȟ ÕÓÅ ÔÈÅ Øψφ ÖÅÒÓÉÏÎȢ 

Demonstration Versions 

Demonstrations versions of Cantabile Solo and Cantabile Performer are available for free 

download but are restricted in the following ways: 

¶ Saving and loading of session files is disabled between runs.  Saving and loading without 

restarting works to allow testing of the session list feature 
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¶ Audio recording is limited to 16-bit audio. 

¶ Times out after 1 hour requiring a restart. 

Registration 

If you have purchased a license for Cantabile Solo or Cantabile Performer, you would also have 

received an email containing your registration details and instructions on how to download the 

software. 

The first time you run the software you will be asked to enter these registration details.  Please 

be sure to pay attention to characters such as the letter I vs the number 1, the letter O vs the 

number 0.  If possible use copy/paste to enter these details. 

Installation 

To install Cantabile, simply run the downloaded setup program.  You will be prompted for some 

basic details and the software will be automatically installed. 

#ÁÎÔÁÂÉÌÅ ÁÌÓÏ ÓÕÐÐÏÒÔÓ ȰØÃÏÐÙ ÄÅÐÌÏÙÍÅÎÔȱ ×ÈÅÒÅ ÙÏÕ ÃÁÎ ÓÉÍÐÌÙ ÃÏÐÙ ÔÈÅ ÅØÅÃÕÔÁÂÌÅ ÆÉÌÅ ÔÏ 

another machine or location and it will run successfully.  Cantabile is not dependant on any 

other DLL files or other files - other than those included in the operating system itself.  If 

deploying Cantabile in this way, file associations can be created and removed using the 

appropriate buttons in General Options. 

Compatibility with Cantabile 1.2 

Cantabile 2.0 will upgrade and load session files, quick sessions and most settings from 

Cantabile 1.2.   

Files created by Cantabile 2.0 are cannot be loaded by Cantabile 1.2.  If Cantabile opens a session 

file from 1.2 you will be prompted before it is overwritten by the new Cantabile 2.0 session file. 

MIDI Controller Assignment and MIDI Filters will also upgrade correctly however note that 

these features are no longer supported in Cantabile 2.0 Lite. 

Copyrights and Credits 

The following copyright and technology acknowledgements apply to this product:  

¶ Cantabile (the software product) and this User Guide are Copyright © 2006-2009 

Topten Software.  All Rights Reserved 

¶ VST Plugin Interface Technology by Steinberg Media Technologies GbmH 

¶ ASIO Interface Technology by Steinberg Soft- und Hardware GbmH 
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CHAPTER 

2 

2 Getting Started 

Introduction to Computer Based Music 

)Æ ÙÏÕȭÒÅ ÎÅ× ÔÏ ÔÈÅ ×ÏÒÌÄ ÏÆ ÃÏÍÐÕÔÅÒ ÂÁÓÅÄ ÍÕÓÉÃ ÔÈÉÓ ÓÅÃÔÉÏÎÓ ÅØÐÌÁÉÎÓ Á ÆÅ× ÏÆ ÔÈÅ basic 

ÃÏÎÃÅÐÔÓ ÙÏÕȭÌÌ ÎÅÅÄ ÔÏ ÕÎÄÅÒÓÔÁÎÄ ÔÏ ÇÅÔ ÔÈÅ ÍÏÓÔ ÏÆ #ÁÎÔÁÂÉÌÅȢ 

)Æ ÙÏÕȭÒÅ ÁÌÒÅÁÄÙ ÆÁÍÉÌÉÁÒ ×ÉÔÈ ÃÏÍÐÕÔÅÒ ÍÕÓÉÃ ÙÏÕ ÃÁÎ ÓËÉÐ ÔÈÉÓ ÓÅÃÔÉÏÎȢ 

MIDI vs Audio 

In computer music, there are two main ways of representing musical information: 

Audio  Audio data is a digital representation of the actual sound waves that 
make up sound.  WAV and MP3 files are typical ways to store audio 
data.  Computer software can be used to process audio data to apply 
effects such as reverb, echo etc... 

MIDI MIDI is standard way of recording the notes that make a piece of music.  
-)$) ÄÏÅÓÎȭÔ ÎÅÃÅÓÓÁÒÉÌÙ ÄÅÆÉÎÅ ÔÈÅ ÓÏÕÎÄ ÏÆ ÅÁÃÈ ÎÏÔÅ ÓÏ Á -)$) ÆÉÌÅ 
can be played back with a different instrument to which it was 
recorded. 

MIDI is not limited to notes ɀ it can also be used to represent other 
controls such as damper pedals, modulation wheel data and more. 

Think of audio as similar to storing music as a CD whereas MIDI is more like sheet music. 

Synthesis, Virtual Instruments and Audio Effects 

Sound synthesis is the process of taking musical notes (typically represented as MIDI data) and 

converting it into an digital sound. ie: the process of converting MIDI to audio. 

A virtual instrument is a piece of computer software that performs this process.  For example, a 

virtual piano accepts MIDI notes as input and generates the sound of a piano playing those 

notes. 

An audio effect is a piece of software that applies effects to an incoming audio signal.  This could 

be anything from simply making it louder of softer, to widening the stereo width or applying 

sophisticated reverb effects (eg: recreating the sound of a large cathedral). 

Virtual Instrument  MIDI In Ą Audio Out 

Audio Effect Audio In Ą Audio Out 
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In general it is not possible to accurately convert from audio to MIDI (though there are some 

programs that can do this reasonably well). 

Plug-ins and Hosts 

Computer music software typically falls into one of two main categories ɀ plugins and hosts.   

A host is the main program that a user uses to create their music and provides the framework 

for routing audio and MIDI between external devices and loadable modules called plugins. 

A plugin is a software module that is loaded by a host to perform a specific function.  Plugins fall 

into two main categories ɀ instruments and effects (as described above).  Other plugin types 

include MIDI effects (which generate MIDI), surround sound processors and analysers. 

Cantabile is a host application that is designed for real-ÔÉÍÅ ÐÅÒÆÏÒÍÁÎÃÅȢ  4ÈÉÓ ÍÅÁÎÓ ÉÔȭÓ 

designed for connecting a MIDI keyboard, microphones and other devices and processing them 

in real-time.  

#ÁÎÔÁÂÉÌÅ ÄÏÅÓ ÎÏÔ ÉÎÃÌÕÄÅ ÁÎÙ ÐÌÕÇÉÎÓ ÁÎÄ ÁÓ ÓÕÃÈ ÙÏÕȭÌÌ ÎÅÅÄ ÔÏ ÁÃÑÕÉÒÅ ÔÈÅÓÅ ÓÅÐÁÒÁÔÅÌÙȢ  &ÒÅÅ 

and commercial plugins are available from many different software developers.  There are a 

number of different plugin formats available, though Cantabile only supports the most popular ɀ 

VST.  VST (short for Virtual Studio Technology) is a standard defined by Steinberg. 

A good source of information on available plugins is KVR Audio ɀ http://www.kvraudio.com  . 

Audio Drivers 

An audio driver is a piece of software that knows how to communicate with a sound card.  

Cantabile uses audio drivers to allow it to work with many different types of sound cards.  In 

order to use Cantabile you will need a compatible audio driver. 

One of the most important features of a good audio driver and sound card is the ability to 

deliver low-latency audio.  Latency is a term used to describe the time delay between the 

computer generating a sound and the sound being heard.  It also describes the delay between 

receiving a sound and that sound being delivered to the computer software.  Latency is 

measured in milliseconds and ideally you will want a latency of no more than about 10ms. 

Cantabile supports two different audio driver standards: 

ASIO ASIO, short for Audio Stream Input/Output is a standard specified by 
Steinberg.  ASIO generally offers very low latency and is the preferred 
type of audio driver. 

DirectSound  DirectSound is a Microsoft technology designed primarily for use in 
games.  Although DirectSound can work well with Cantabile it should 
generally be considered less stable than ASIO. 

If your sound card came with an ASIO driver you should use that driver ɀ particularly if it is a 

professional quality sound card.  If your sound card did not come with an ASIO driver a good 

option is the excellent generic ASIO driver ASIO4ALL available from http://www.asio4all.com . 

In addition to these standard audio driver types, Cantabile also includes a null audio driver.  The 

ÎÕÌÌ ÁÕÄÉÏ ÄÒÉÖÅÒ ÄÏÅÓÎȭÔ ÐÒÏÄÕÃÅ ÁÎÙ ÓÏÕÎÄÓ ÂÕÔ ÁÌÌÏ×Ó ÔÈÅ ÁÕÄÉÏ ÅÎÇÉÎÅ ÔÏ ÒÕÎ ÁÓ ÉÆ Á ÓÏÕÎÄ 

card was attached.  This is mostly useful for using Cantabile as a MIDI only processor. 

http://www.kvraudio.com/
http://www.asio4all.com/
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Bringing it All Together 

So to bring all this together, Cantabile is a host application for VST plugins.  It accepts incoming 

MIDI and audio data and can route it to one or more VST plugins.  The audio and MIDI generated 

by these plugins can then be routed to speakers and other external MIDI devices. 

Typical uses of Cantabile include: 

¶ Playing virtual instruments by connecting a MIDI keyboard to your computer, routing 

the incoming MIDI to a virtual instrument and sending the generated sounds to a set of 

speakers. 

¶ Real-time audio processing by connecting a microphone to your computer, routing the 

incoming audio to an audio effect and then sending the output of that to a set of 

speakers. 

In addition to this basic routing capability, Cantabile can also: 

¶ Record audio and MIDI streams to files. 

¶ Playback audio and MIDI streams from files. 

¶ Process MIDI in special ways such as changing the velocity with which notes are played 

to better suit your playing style (MIDI filters) 

¶ Control plugin settings remotely from a MIDI device (MIDI Controller Assignments). 

¶ Process multiple plugins in series - route the output of one plugin to the input of 

another.  Eg: a MIDI generating plugin connected to a virtual instrument, in turn  

connected to an audio effect etc... 

¶ Process multiple plugins in parallel ɀ process incoming audio on one rack and load a 

virtual instrument on another, or perhaps two separate instruments. 

¶ Control timing and synchronisation 

¶ Manage plugin presets 

¶ Lots more... 

$ÏÎȭÔ ÂÅ ÔÏÏ ÄÁÕÎÔÅÄ ÉÆ ÙÏÕ ÄÉÄÎȭÔ ÆÏÌÌÏ× ÁÌÌ ÏÆ ÔÈÅ ÁÂÏÖÅȢ  )ÎÓÔÁÌÌ #ÁÎÔÁÂÉÌÅȟ ÄÏ×ÎÌÏÁÄ ÓÏÍÅ 

plugins and just start playing ɀ ÙÏÕȭÌÌ ÓÏÏÎ ÇÅÔ ÔÈÅ ÉÄÅÁȢ 

Starting Cantabile 

To start Cantabile, simply click the short cut that the installation program would have created in 

your Windows Start Menu. 

9ÏÕ ÃÁÎ ÁÌÓÏ ÒÕÎ #ÁÎÔÁÂÉÌÅ ÉÎ ÁÎ ȰÁÌÔÅÒÎÁÔÅ ÃÏÎÆÉÇÕÒÁÔÉÏÎȱ.  Alternate configurations maintains a 

completely separate set of settings.  This can be useful for diagnosing problems, or if you need 

run Cantabile against two different sets of devices.  The installation program would have 

ÃÒÅÁÔÅÄ ÏÎÅ ÁÄÄÉÔÉÏÎÁÌ ÃÏÎÆÉÇÕÒÁÔÉÏÎ ÎÁÍÅÄ Ȱ!ÌÔ #ÏÎÆÉÇȱ ÉÎ ÙÏÕÒ ÓÔÁÒÔ ÍÅÎÕȢ  9ÏÕ ÃÁÎ ÃÒÅÁÔÅ ÁÓ 

many custom configurations as you like (see Alternate Configurations). 

Configuring Cantabile 

Before Cantabile can run correctly, it needs to have various settings configured.  To help with 

this the first time Cantabile is run, the Quick Configure dialog ÉÓ ÄÉÓÐÌÁÙÅÄ ×ÈÅÒÅ ÙÏÕȭll be asked 

to select an audio driver, one or more MIDI devices and the location of your VST plug-ins folder: 
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The Quick Configure dialog 

Selecting an Audio Driver 

When selecting an audio driver, choose the ASIO driver that matches the sound card of your 

ÃÏÍÐÕÔÅÒȢ   )Æ ÙÏÕÒ ÓÏÕÎÄ ÃÁÒÄ ÄÏÅÓÎȭÔ ÈÁÖÅ ÁÎ !3)/ ÄÒÉÖer you might consider using ASIO4ALL 

(a free ASIO driver that works with most computers available from http://www.asio4all.com ). 

DirectSound driver support is included for compatibility; however ASIO is the preferred driver 

model. 

The Null Audio driver is a built in driver that emulates a sound card so Cantabile can run 

ÃÏÒÒÅÃÔÌÙȟ ÂÕÔ ÄÏÅÓÎȭÔ ÐÒÏÄÕÃÅ ÁÎÙ ÓÏÕÎÄȢ  )Ô ÉÓ ÕÓÅÆÕÌ ÐÒÉÍÁÒÉÌÙ ×ÈÅÎ ×ÏÒËÉÎÇ ×ÉÔÈ -)$) ÏÎÌÙȢ 

Selecting MIDI Devices 

Place check marks next to any MIDI input/output devices you wish to use.    

When choosing MIDI devices in other parts of Cantabile, only those selected will be shown.  By 

selecting only the devices you will actually be using, you can avoid cluttering these menus with 

unneeded choices. 

In Cantabile Performer, you will also have the option to select which MIDI devices will send and 

receive MIDI clock.  You can enable MIDI clock for a device by right clicking on the device or by 

double clicking in the Clock column. 

Specifying VST Plug-in Folders 

To use VST plug-ins, Cantabile needs to know where you have these installed on your computer.  

Either manually type the location of this folder, or use the Browse  button to locate the folder. 

http://www.asio4all.com/
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)Æ ÙÏÕ ÄÏÎȭÔ ÈÁÖÅ ÁÎÙ ÐÌÕÇ-ins installed, you may leave this field blank for now.  For a 

comprehensive list of free and commercial plug-ins please visit http://www.kvraudio.com . 

More Options 

Cantabile has many more options and settings. Click the More Options  button to adjust these 

settings. 

Getting Back to Quick Configure 

!ÌÌ ÏÆ ÔÈÅ ÓÅÔÔÉÎÇÓ ÉÎ ÔÈÅ 1ÕÉÃË #ÏÎÆÉÇÕÒÅ ÄÉÁÌÏÇ ÁÒÅ ÁÌÓÏ ÁÖÁÉÌÁÂÌÅ ÆÒÏÍ #ÁÎÔÁÂÉÌÅȭÓ /ÐÔÉÏÎÓ 

window ; however you can re-show the Quick Configure dialog by either: 

¶ Holding Ctrl+Alt+Shift  while Cantabile is starting. 

¶ Running Cantabile with the /clean command line argument. 

Ready 

/ÎÃÅ ÙÏÕȭÖÅ configured all the above settings press the OK button.   

Cantabile will scan your plug-ins folder, start the audio driver and MIDI devices and prepare a 

new empty session for you to start working with. 

9ÏÕȭÒÅ ÎÏ× ÒÅÁÄÙ ÔÏ ÓÔÁÒÔ ÕÓÉÎÇ #ÁÎÔÁÂÉÌÅȢ   

Playing Virtual Instruments 

Cantabile allows real-time playing of virtual instruments from an external MIDI device.   

Before continuing you must have at least one VST instrument plugin installed on your computer.    

To play a virtual instrument: 

¶ On Cantabile's main screen, make sure the panel Racks and Plugins is expanded and 

click New Plugin  button.  

¶ Select the Instruments  category on the left and locate and click on the name of a plugin 

on the right. 

¶ The plugin will be loaded and its settings displayed.  You can close this window for now. 

¶ You should be able to now play the instrument from either an external keyboard, or with 

the onscreen keyboard. 

http://www.kvraudio.com/
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Selecting a ÐÌÕÇÉÎ ×ÉÔÈ #ÁÎÔÁÂÉÌÅȭÓ ÐÌÕÇÉÎ ÓÅÌÅÃÔÏÒ 

If you hear no sound, check the following: 

¶ When playing an external keyboard, check that the same keys on the on-screen 

keyboard light up.  If not, there is a problem with your MIDI configuration.  

¶ If the on-screen keys light up, check whether the output level meter on the main screen 

is indicating any audio output.  If it is then there is a problem with your audio 

configuration.  

¶ Next you should check the settings of the plugin itself.  Click the Edit  button in the plugin 

slot to display the plugins user interface.  Check the plugin's settings.  Some plugins 

require sample libraries or presets to be loaded before they produce any sound.  

¶ Finally, check the output level setting on Cantabile's main screen and Window's volume 

settings. 

Audio Effects 

Similarly to playing virtual instruments, Cantabile can also process audio signals in real-time.   

For example you can connect a microphone to your computer and use Cantabile process the 

incoming audio using a reverb or other effect plugin and send the output back to a set of 

speakers in real time. 

The steps for this are essentially the same as for a virtual instrument except: 

¶ Instead of loading an instrument plugin, load an audio effect plugin.  

¶ Make sure audio input is enabled but selecting the Input  check box in the master levels 

panel. 
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Enabling Audio Input 

¶ Connect the rack's input to audio input by clicking the Input Connect  button on the rack 

slot: 

 

Connecting a rack to audio input 

Be careful when using audio input not to create feedback loops where the incoming sound is 

processed, and sent to output where it's picked up again as audio input.  Typically this will 

produce a loud screeching or whistling noise but can be reduced by lowering input or output 

levels, disabling input or simply moving microphones and pickups away from speakers.  This 

can also happen with some sound cards that return output signals as input.  Refer to your sound 

cards documentation for information how to disable this. 

If audio processing doesn't appear to be working: 

¶ Check the audio input level meter on Cantabile's main screen.  This meter will light up 

when Cantabile is receiving audio input.  If it doesn't check your audio connections and 

audio driver settings.  

¶ Check the audio output level meter.  This meter will indicate audio output from the 

loaded plugin.  If this this meter isn't showing any audio activity, check the settings of 

the loaded plugin.  

¶ Finally, check the output level setting on Cantabile main screen and Window's volume 

settings. 

Master Levels 

The Master Levels  group on the Home tab can be used to control the master input and output 

gains.  You can also enable or disable input/output and view the current output levels. 
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Master Levels group on the Home tab 

Recording 

Cantabile supports recording audio and MIDI files and both recorders can be controlled from 

the Record tab. 

To Record MIDI Input: 

¶ Ensure MIDI input is working correctly. 

¶ Switch to the Record tab (using the mouse or press Alt+R ). 

¶ Click the Auto Record button in MIDI Recorder  group. 

¶ Start playing the MIDI device you want to record from. 

¶ Cantabile should automatically start recording when you start playing. 

¶ Recordings are shown in the recording panel (see below). 

Recording audio is nearly identical to recording MIDI - simply click the other Auto Record  

button in the Audio Recorder  group. 

Instead of recording audio or MIDI input, you may want to record output (ie: the signals coming 

out of Cantabile as opposed to those being received).  To select whether to record input or 

output, click the buttons on the record tab titled Record Input  and/or Record Output . 

Managing Recordings 

All recordings you make will appear in the Recordings list:  

 

The Record tab and Recordings List 
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Pinned records will be kept while unpinned recording will be deleted when the session is 

closed.  You can select whether to automatically pin all new recordings (optimistic recording), 

or only those you select (pessimistic recording) in Recordings List Options. 

You can also delete, rename or explore recording files by right-clicking the recording. 

Playing Media Files 

Cantabile supports the playback of audio and MIDI media files.  To load a file for playback: 

¶ Expand the Media Files panel 

¶ Click the New Media File  button 

¶ Select the Open... command to browse for a media file. 

¶ 0ÒÅÓÓ ÔÈÅ ÆÉÌÅȭÓ Play button to start playback. 

 

Playing a MIDI file 

Some notes about playing media files: 

¶ You can load multiple media files at once and trigger them either individually or 

together. 

¶ The Send To drop down for each media file specifies where the output of the media file 

is directed.  By default, each media file is directed to the main input of the racks/plugins. 

¶  Media files can be looped by selecting a play range (by dragging on the visual 

representation of the loaded file). 

Saving and Loading Sessions 

/ÎÃÅ ÙÏÕȭÖÅ ÃÏÎÆÉÇÕÒÅÄ #ÁÎÔÁÂÉÌÅ ÙÏÕ ÃÁÎ ÓÁÖÅ that state to a session file.  Session files store all 

ÏÆ #ÁÎÔÁÂÉÌÅȭÓ ÓÅÔÔÉÎÇÓ ÅØcept for global options and settings. 

To save a session file: 

¶ From the Application Menu (Alt+F), select the Save command (or just press Ctrl+S) 

¶ Enter a filename for the session. 

¶ Press OK to save the file. 

To load a session file: 

¶ From the Application Menu, select the Open command (or press Ctrl+O) 

¶ Locate and select the session file to load. 

¶ Press OK to load it. 
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Cantabile also keeps a list of recently used session files in the list on the right side of the 

Application MenuȢ  9ÏÕ ÃÁÎ ȰÐÉÎȱ ÆÁÖÏÕÒÉÔÅ ÅÎÔÒÉÅÓ ÈÅÒÅ ÔÏ prevent them from being pushed off 

the bottom of the list. 

/ŀƴǘŀōƛƭŜΩǎ Main Window 

 

#ÁÎÔÁÂÉÌÅȭÓ -ÁÉÎ 7ÉÎÄÏ× 

The Application Menu 

The Application Menu is displayed by clicking the round button in the top left corner of the main 

window.  The Application menu is similar to the File menu in most applications and contains 

commands for creating, saving and loading session files, setting options and exiting the 

program. 

The application menu can be accessed through the keyboard by pressing Alt+F .  

The Ribbon 

The ribbon is the main toolbar at the top of the main window.  The ribbon consists of several 

tabs, each with a different set of commands: 

Home Most common commands and settings. (Alt+H ) 

Record Commands for controlling the audio and MIDI recorders.  (Alt+R ) 

Setup Commands related to setting up Cantabile or a session. (Alt+S) 

To save screen space, the ribbon can be minimized to just show the tabs.  To minimize or 

restore the ribbon, double click on one of the tabs. 
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Besides clicking on the tabs, you can also switch between tabs using the mouse wheel while the 

cursor is over the ribbon. 

Quick Access Toolbar 

The Quick Access Toolbar is the small toolbar typically displayed just to the right of the 

Application Button in the title bar area. 

The Quick Access Toolbar contains commands that are often used and can it be customized to 

suit your working style.   

To add a command to the ribbon: 

¶ Right click on any toolbar command and select Add to Quick Access Toolbar  

¶ Click the drop down arrow to the right of the Quick Access Toolbar to select additional 

commands. 

To remove a command from the ribbon: 

¶ Right click on the command in the Quick Access Toolbar and select Remove from Quick 

Access Toolbar. 

To re-order commands on the Quick Access Toolbar: 

¶ From the Application menu select Cantabile Options  

¶ Switch to the Customize page. 

¶ Click the command to be moved in the right hand list. 

¶ Use the Up/Down buttons to move the item up or down. 

The Quick Access Toolbar can also be positioned below the ribbon.  This is especially useful if 

you have many commands and not enough room in the title bar to display them all.  To move the 

Quick Access Toolbar, click the drop down button to its right and select Show Below the 

Ribbon .  

Main Panels 

Most of the main window is comprised of several panels that can be expanded or collapsed as 

required.  Depending on which edition of Cantabile you're using you may have the following 

panels: 

MIDI Routing Table  Defines routings between MIDI devices 

Triggers  Defines actions to execute on certain events (typically used to 
configure external MIDI devices for a session) 

Media Files MIDI and audio file players. 

Racks and Plugins Plugins organised into racks. 

Keyboard  An onscreen piano style keyboard and several controllers for testing 
plugins with. 

Most of these panels can be: 

¶ Resized by dragging the divider between them.   

¶ Maximized by clicking square box icon in its top right corner. 

¶ Hidden by clicking the cross icon in its top right corner. 

¶ Hidden or shown by clicking the Show/Hide Panels  drop down button on the far right 

of the Home tab. 
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Status Bar 

The status bar appears at the bottom of the main window and can be configured to show a wide 

range of indicators.  To customize the status bar, right click on it and select the elements to be 

displayed. 

Most of the status bar indicators are self-explanatory except perhaps the following: 

¶ The memory indicator shows memory usage, displayed in the format x/y (n) where x is 

physical memory used, y is virtual memory allocated and n is the number of page faults 

in the previous 1 second.  For optimal performance, x and y should be almost equal (or x 

> y) and n should normally be 0. 

¶ The record indicators glow green if auto record is enabled and red when recording.  The 

first indicator is the audio recorder, the second the MIDI recorder. 

¶ The MIDI indicators glow green when MIDI connectivity is detected (eg: active sense or 

MIDI clock) and red when MIDI data activity is detected.  The first indicator represents 

MIDI-in activity, the second internal MIDI activity (eg: a MIDI file playing) and the third 

indicates MIDI-out activity. 

Dock Panels 

Cantabile has two dock panels that appear to the left of the main panels.  

Sub-sessions * A list of all sub-sessions for the current 
session. 

Recordings  A list of recordings made during this session. 

* Cantabi le Performer Only 

These panels can be shown by associated commands on the ribbon toolbars, or by pressing 

Ctrl+1  for the sub-session list and Ctrl+2  for the recordings list.  To hide a dock panel, click its 

close icon or press Shift+Escape while it has keyboard focus. 

 Keyboard Control 

Cantabile can be driven completely by the PC keyboard which many users will find faster than 

using the mouse.  Note the following about using Cantabile with the keyboard: 

¶ The ribbon and most commands can be accessed by pressing the Alt  key followed by a 

series of letters.  To learn these letters, press and hold the Alt  key.  After a short period a 

set of key tips will appear showing the available keystrokes.  Once you've learned the 

keystrokes, you don't need to wait for the key tips and you can simply key ahead. 

¶ Moving around within the main panels and dock panels is typically done with the arrow 

keys. 

¶ To move focus between panels, using Ctrl+Tab  and Ctrl+Shift+Tab  

¶ Buttons and drop downs can be activated with the Enter  key.  Note that although most 

applications activate buttons with the spacebar, in Cantabile the spacebar is used to 

start/stop the master transport. 

¶ Many commands also have Ctrl  key shortcuts.  To discover these, simply hover over the 

command and the short-cut key (if available) will be shown in the tooltip. 

As a final note on using the keyboard, don't forget that if the on-screen keyboard's capture 

ÆÅÁÔÕÒÅ ÉÓ ÅÎÁÂÌÅÄȟ ÍÏÓÔ ÓÈÏÒÔÃÕÔ ËÅÙÓ ×ÏÎȭÔ ×ÏÒË ÁÓ ÔÈÅÙͻÌÌ ÂÅ ÃÏÎÔÒÏÌÌÉÎÇ ÔÈÅ ÏÎ-screen 

keyboard instead. 
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General Editing Tasks 

This section describes common editing features that can be used when working with Plugins, 

Racks, Media Files, Triggers and MIDI Routing Tables. 

Creating New Items 

To create a new item click the New Item  button that appears near the bottom of each panel.  

Depending on the type of item it will be either created immediately or a popup will be displayed 

where additional options are available. 

For plugins, the New Plugin  button is contained within the parent rack, which must be 

expanded to be visible. 

Plugins and Media Files can be replaced using the Replace button near the start of the slot. 

Deleting Items 

To delete an item: 

¶ Select the item to be deleted by navigating to it with the keyboard, or by clicking on its 

name. 

¶ Press the Delete  key, or click the Delete  command on the Home tab. 

Note: 

¶ Deleting a rack will also delete all contained plugins 

¶ Most delete operations can be undone, though in some cases routings between deleted 

items may not be restored correctly. 

Renaming Items 

Although not necessary for Cantabile to function correctly, renaming items to give them more 

meaningful names is a convenient way to make your sessions more understandable. 

To rename an item: 

¶ Select the item to be renamed by navigating to it with the keyboard, or by clicking on its 

name. 

¶ Press the F2 key, or right click on the item's name and select Rename, 

¶ Enter a new name for the item 

¶ Press OK. 

Using the Clipboard 

Most items can be manipulated using the clipboard. 

To cut or copy an item: 

¶ Select the item to be cut or copied by navigating to it with the keyboard, or by clicking 

on its name. 

¶ To copy the item, press Ctrl+C. 

¶ To cut the item, press Ctrl+X . 

Pasted items are always inserted before the currently selected item.  To paste an item at the 

end, select the New Item  button at the bottom of the list. 

¶ Select the item to paste before. 

¶ Press Ctrl+V . 
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Note: clipboard commands are also available from the Home tab and by right clicking on items. 

Using Drag/Drop 

Items can be rearranged and duplicated using drag drop: 

To change the order of items: 

¶ Click on the name of the item to be moved. 

¶ Hold the mouse button on while dragging up or down to choose a new position for the 

item. 

By holding the Ctrl  key while dragging you can create a copy of the item at the new location. 

Undo and Redo 

Many operations can be Undone (and then redone): 

¶ To undo the last operation, press Ctrl+Z  

¶ To redo the last undone operation, press Ctrl+Y 

Note, that only Cantabile related operations can be undone.  For example, changes made to a 

plugin's own settings are not stored in the undo buffer. 

The Undo and Redo commands are also available on Quick Access Bar. 
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3 Working with Plugins 

Understanding Racks and Plugins 

Cantabile supports loading multiple plugins through a simple rack approach (as opposed to a 

completely free-form wiring method).  This approach provides a flexible yet easy to use 

mechanism for connecting plugins. 

A rack is simply an ordered list of plugins where each plugin is connected to the one after.  The 

rack's input is connected to the input of the first plugin and the output of the last plugin 

becomes the rack's output. 

The input of each rack can optionally be connected to audio input from the audio driver.   

Similarly, each rack can be optionally configured to response to a specific MIDI device/channel. 

The output of each rack can be routed to either your external hardware (sound card output or 

MIDI output device) or to another rack.   

The following example shows two racks routed to the input of a third. 

 

Rack Wiring Diagram 

Within each rach, each plugin slot supports a wet/dry mixer and a MIDI pass-through setting: 



22   Chapter 3 - Working with Plugins   

 

Plugin Wiring Diagram 

Cantabile Lite supports two racks of two plugins.  Cantabile Solo and Performer support 

unlimited racks and unlimited plugins. 

Dry and Wet Mix Levels 

The dry mix level of a plugin determine how much of unprocessed incoming audio signal should 

be passed through to the next plugin. 

The wet mix level determines the amount of output signal from the plugin that should be passed 

through to the next plugin. 

The wet and dry mix levels can be used to determine the volume of an instrument or amount of 

effect to be applied in the overall output. 

MIDI Pass Through 

By default only MIDI generated by a plugin will be passed to the next plugin.  When the MIDI 

pass through setting is enabled, both incoming events and events generated by the plugin are 

passed to the next plugin. 

This setting can be used in combination with a plugin's MIDI filters to create multi-timbral 

instruments on a single rack. 

Audio Master Bus 

Rather than providing direct pin to pin connections between plugins, Cantabile has a concept of 

a master bus that plugins are connected through. 

The master bus is a set of audio channels that is fixed to stereo left/right in Cantabile Lite or can 

be configured to multichannel formats in Cantabile Solo and Performer. 

The input and output pins of each plugin are connected to the master bus.  Cantabile supports 

multiple N-N connections between a plugin and the master bus allowing simple but flexible 

configuration of audio channel assignments. 
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To adjust the audio channels of a plugin, from the plugin slot's Tools  drop down menu select 

Audio Channels . 

To set the format of the master bus, from the Setup tab select Configure Master Bus . 

Partial Sends 

Cantabile Performer also supports partial sends.  A partial send is typically used to send part of 

the output signal of a rack to an effects rack.  Partial sends only applies to the audio signal (not 

-)$)Ɋ ÁÎÄ ÐÅÅÌÓ ÏÆÆ Á ÐÅÒÃÅÎÔÁÇÅ ÏÆ ÔÈÅ ÒÁÃËȭÓ ÏÕÔÐÕÔȟ ×ÈÉÌÅ ÌÅÁÖÉÎÇ ÔÈÅ ÄÉÒÅÃÔ ÓÉÇÎÁÌ ÕÎÁÌÔÅÒÅÄȢ 

You may configure up to two partial sends for each rack.  Each partial send can be routed to any 

other rack - ÓÏ ÌÏÎÇ ÁÓ ÔÈÉÓ ×ÏÕÌÄÎȭÔ ÃÁÕÓÅ Á ÃÉÒÃÕÌÁÒ ÒÏÕÔÉÎÇȢ 

 

Configuring Partial Sends in Cantabile Performer 

Each ÐÁÒÔÉÁÌ ÓÅÎÄ ÃÁÎ ÂÅ ÃÏÎÆÉÇÕÒÅÄ ÔÏ ÂÅ ÔÁËÅÎ ÅÉÔÈÅÒ ÂÅÆÏÒÅ ÏÒ ÁÆÔÅÒ ÔÈÅ ÒÁÃËȭÓ ÏÕÔÐÕÔ ÇÁÉÎ ÉÓ 

applied.  When the option Send Before Gain is ÓÅÌÅÃÔÅÄȟ ÁÄÊÕÓÔÉÎÇ ÔÈÅ ÒÁÃËȭÓ ÇÁÉÎ ÄÏÅÓÎȭÔ ÁÆÆÅÃÔ 

the sent signal. 

Plugins and Racks Panel 

Plugins and racks are created and edited using the Plugins and Racks panel which is one of the 

ÅØÐÁÎÄÁÂÌÅ ÐÁÎÅÌÓ ÏÎ #ÁÎÔÁÂÉÌÅȭÓ ÍÁÉÎ ×ÉÎÄÏ×Ȣ  4Ï ÕÓÅ ÔÈÉÓ ÐÁÎÅÌȟ ÍÁËe sure it is visible and 

expanded (see Main Panels) 

Rack Settings 

Each rack is headed by a set of controls for the rack as a whole: 

 

 

 

 

 

Rack Expand/Collapse 

Bypass 

Mute 

Solo 

Input Connect 

 

Partial Send 

Amounts 
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Rack Expand Button Clicking this button expands or collapses the rack's list of plugins.  
You can also use Ctrl+Left  and Ctrl+Right  to expand and collapse 
the rack. 

Rack Bypass Button When bypassed, all plugins in a rack are suspended from 
processing and all audio and MIDI input to the rack is passed 
directly to the rack's output. 

Rack Mute Button  When muted, all plugins are suspended and any incoming audio or 
MIDI is discarded. 

Rack Solo Button Clicking the Solo button for a rack effectively mutes all other racks.  
You can solo multiple racks by holding the Ctrl  key while clicking 
the Solo button. 

Input Connect Button  Clicking this option connects the input of this rack to audio input 
from your sound card. 

Rack Name A name describing the rack.  By default Cantabile assigns rack 
names similar such as "Rack 1", "Rack 2" etc...   

You can rename a rack by selecting the rack and pressing F2, or by 
right clicking the rack's name and selecting the Rename command. 

MIDI -In Device and 
Channel Number  

The MIDI device and channel number that this rack responds to.   

Note that this setting can be overridden by the MIDI Routing Table 
where any MIDI events explicitly routed to rack are accepted by 
the rack regardless of this setting.  

Split/Transpose *  Specifies a sub-session controllable keyboard range and/or 
transpose amount for this rack. 

See Rack Split and Transpose. 

Send To This setting determines where to send the output of this rack.   

Racks can be routed to either Output  (ie: the sound card) or to 
another rack.  When routed to output, there is an additional set of 
options that allow routing of MIDI events to a specific MIDI output 
device. 

In Performer, this menu is also used to configure up to two Partial 
Sends. 

Partial Send  
Amount s ** 

Adjusts the send amount percentage for each of the partial sends. 

Gain The output level gain for this rack. 

Level Meter  Shows the output level of this rack. 

* Cantabi le Solo and Cantabile Performer Only 

** Cantabile Performer Only 

 



Chapter 3 - Working with Plugins  25 

Plugin Settings 

Within each rack you can create a chain of plugins.  Each plugin slot has the following controls: 

 

 

 

 

 

Bypass Button When a plugin is bypassed, all incoming audio and MIDI data is 
ÐÁÓÓÅÄ ÔÈÒÏÕÇÈ ÔÏ ÔÈÅ ÎÅØÔ ÐÌÕÇÉÎ ɉÏÒ ÔÈÅ ÒÁÃËȭÓ ÏÕÔÐÕÔ if the plugin 
is the last in the rack).   

The plugin is left running however, allowing still sounding notes 
and effects to sound out.  This option is also useful for situations 
for slow starting plugins that need to be resumed quickly. 

Suspend Button A suspended plugin is similar to a bypassed button in that all 
incoming audio and MIDI is passed through.   

When suspended however, the plugin is no longer processed 
causing still sounding notes and effects to be cut off.  When 
suspended however processing load is saved. 

Replace Plugin Drop 
Down 

Clicking this button allows selecting a new plugin to replace the 
existing plugin in this slot. 

Plugin Name The name of the plugin in this slot.   

By default, plugins are named according to the type of plugin they 
contain.  You can rename plugin slots to provide a more descriptive 
name by selecting the plugin and pressing F2, or right clicking the 
plugin's name and selecting the Rename command. 

Program Most plugins support more than one program.  A program is a 
prÅÄÅÆÉÎÅÄ ÓÅÔ ÏÆ ÓÅÔÔÉÎÇÓ ÔÈÁÔ ÃÏÎÔÒÏÌ ÔÈÅ ÐÌÕÇÉÎȭÓ ÓÏÕÎÄ ÁÎÄ 
behaviour. 

The program selector drop down can be used to select a program 
or you can use the next/previous buttons to move through the set 
of programs.   

When the plugin slot is active, the N and P keys can also be used to 
move to the next and previous programs. 

Edit Button  The edit button displays the plugin custom user interface if it has 
ÏÎÅ ɉÍÏÓÔ ÐÌÕÇÉÎÓ ÄÏɊȟ ÏÒ #ÁÎÔÁÂÉÌÅȭÓ ÂÕÉÌÔ ÉÎ ÐÌÕÇÉÎ ÅÄÉÔÏÒ 
otherwise. 

Inplace Plugin Editor  Displays the ÐÌÕÇÉÎȭÓ ÕÓÅÒ ÉÎÔÅÒÆÁÃÅ ×ÉÔÈÉÎ #ÁÎÔÁÂÉÌÅȭÓ ÍÁÉÎ 
window (in the Plugin View panel) 

Tools ĄPlugin's Editor  Displays the plugin's custom user interface (if supported). 

Tools ĄBuilt -in Editor  Displays Cantabile's built in parameter editor for the plugin. 

Tools ĄSave Plugin 
Selector Preset 

3ÁÖÅÓ ÔÈÅ ÐÌÕÇÉÎȭÓ ÃÕÒÒÅÎÔ ÐÒÅÓÅÔ ÏÒ ÂÁÎË ÔÏ ÔÈÅ Presets group in 
the plugin selector. 

Bypass 

Suspend 

Replace Plug-in 

 

MIDI Pass-through 

 

In-place Edit 
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Tools ĄProgram 
Organiser  

Displays the program organiser which can be used to manage the 
ÐÌÕÇÉÎȭÓ ÐÒÏÇÒÁÍ ÂÁÎËȢ 

Tools ĄSub-Session 
Behaviour  

Allows specifying which plugin attributes are controlled by sub-
sessions. 

Tools ĄImport 
Program or Bank  

Loads a bank (fxb) or preset (fxp) file into the plugin. 

Tools ĄExport Bank  Saves the plugin as a bank (fxb) file 

Tools ĄExport 
Program 

Saves the current program as a preset (fxp) file 

Tools ĄAudio 
Channels 

Assigns audio channels between the plugin and the session's 
master bus. 

See Audio Channel Assignments. 

Tools ĄMIDI Filters  Defines MIDI fil ters to manipulate incoming MIDI events for this 
plugin 

Tools ĄMIDI Pass 
Through  

When selected, passes incoming MIDI to this plugin and to the next 
plugin. 

When cleared, only MIDI events generated by the plugin are passed 
to the next plugin. 

Use this option to layer multiple VST instruments in the same rack, 
or to pass controller events to a series of plugins. 

Tools ĄSuppress MIDI 
Program Changes 

When selected, MIDI Program Changes are not passed to the 
plugin.   

This option is useful when playing MIDI files that have program 
change events that are inadvertently resetting the program loaded 
by a plugin. 

Tools ĄRecord MIDI 
Output  

When selected, causes MIDI generated by this plugin to be passed 
to the MIDI recorder. 

Wet/dry mix and gain 
sliders  

Controls the wet and dry mix levels of this plugin.  See Wet/Dry 
Mix Settings. 

Pan Controls the left/right panning of mono plugins or the stereo 
balance of stereo/multi -channel plugins.   

The panning laws use to pan signals can be controlled via the 
panning law setting in Master Bus Configuration. 

Unloaded Plugins 

A plugin can be unloaded without actually deleting it.   

7ÈÅÎ ÕÎÌÏÁÄÅÄȟ #ÁÎÔÁÂÉÌÅ ÓÁÖÅÓ ÔÈÅ ÐÌÕÇÉÎȭÓ ÅÎÔÉÒÅ ÓÔÁÔÅȟ ÃÌÏÓÅs the plugin and removes it from 

memory.  If the session is saved while a plugin is unloaded, its saved state is written to the 

session file.    

When an unloaded plugin is reloaded, Cantabile loads the plugin and restores it from the saved 

state. 

To unload a plugin: 

1. Right click on its name and select Unload . 
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2. The plugin will be unloaded and appear as a suspended plugin with most controls 

disabled. 

To reload an unloaded plugin: 

1. Right click on it again and select Reload , or 

2. Click its bypass button. 

Unloaded plugins are an easy way to completely disable a plugin without actually deleting it.  

This feature works particularly well in conjunction with sub-session where some sub-sessions 

ÈÁÖÅ ÔÈÅ ÐÌÕÇÉÎ ÌÏÁÄÅÄ ÁÎÄ ÓÏÍÅ ÄÏÎȭÔȢ 

Unloaded plugins are also used when a session contains a plugin that fails to load.  In this case, 

the state of the plugin is read from the session file and stored as the unloaded state.  Re-saving 

the session will not cause the saved state to be lost and the session can be repaired by installing 

the missing plugin. 

Wet/Dry Mix Settings 

The meaning of Á ÐÌÕÇÉÎ ÓÌÏÔȭÓ wet and dry mix sliders depends on the Use Wet/Dry Controls  

option in Plugin Options. 

When the Use Wet/Dry Controls option is enabled (the default) the wet and dry mix levels are 

controlled separately: 

Dry Slider  Controls the amount of dry signal that is passed through the plugin slot.  
The dry signal is the input to the plugin slot.  

Wet Slider  Controls the amount of wet signal that is included in the output of this 
plugin slot.  The wet signal is the output of the plugin itself. 

When the option to use wet/dry mix levels is turned off, the behaviour of these sliders changes 

depending on whether the plugin is an effect or instrument. 

For instrument plugins: 

Plugin Slider  Controls the gain of the plugin itself (ie: same as wet mix) 

Gain Slider Controls the gain of the plugin slot as a whole.  ie: it is a gain that is 
applied after the plugin gain is applied and mixed. 

For other types of plugins: 

Plugin Slider  Controls the wet/dry balance 

Gain Slider Controls the overall gain of the plugin slot. 

Plugin Selector 

The plugin selector is used to insert new plugins, or to replace the plugin in a plugin slot. 
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The Plugin Selector 

Plugin Groups  Download the left side of the plugin selector are a number of 
plugin groups.  Selecting a group shows the plugins belonging to 
that group in the list on the right hand side. 

Favourites Group  SÈÏ×Ó ÁÌÌ ÐÌÕÇÉÎÓ ÔÈÁÔ ÈÁÖÅ ÂÅÅÎ ȰÐÉÎÎÅÄȱ ÁÓ ÆÁÖÏÕÒÉÔÅÓȢ   

Each plugin in the list has a pin icon.  By clicking the pin icon 
you can control which plugins appear in the favourites group. 

Recent Group Shows plugins that have been recently used. 

Presets Group 

 

Shows all preset (fxp) and bank (fxb) files that have been saved 
to a special presets folder.   

See Plugin Options. 

All Plugins Group  Shows all available plugins. 

Instruments, Effects 
and Other Groups 

Shows plugins of a particular plugin type. 

Plugin List  The list on the right shows all plugins in the selected plugin 
group. 

Group By Folder  When selected, the entries in the plugin list are displayed in a 
hierarchical view matching the file system folders containing 
the plugins.   

When not selected, all plugins are displayed in a single flat list, 
sorted alphabetically.  

Scan Plugin Folders Press to update the set of plugins by re-scanning your plugin 
folders. 

Choose File/Plugin  Press to browse for a plugin (dll), preset (fxp) or bank (fxb) file. 
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In-place Plugin Editor 

The in-place plugin eÄÉÔÏÒ ÄÉÓÐÌÁÙÓ Á ÐÌÕÇÉÎȭÓ ÕÓÅÒ-ÉÎÔÅÒÆÁÃÅ ×ÉÔÈÉÎ #ÁÎÔÁÂÉÌÅȭÓ ÍÁÉÎ ×ÉÎÄÏ× - as 

opposed to display it in a separate popup window. 

Only one plugin can be displayed in the in-place editor and it is only supported on plugins that 

provide a custom user-interface (nearly all plugins). 

To display a plugin in-place, simply click the in-place edit button: 

 

 

 

The plugin will appear in the Plugin View  panel: 

 

Inplace Plugin Editor 

 

Plugin Editor 

The plugin editor displays the user interface of a plugin and various other tools and commands 

provided by Cantabile. 

To display the plugin editor, in the plugin slot click the Edit  button or double click on the 

ÐÌÕÇÉÎȭÓ name. 

Edit In-place  

 


